
 Quick Guide  
  

 
Updated       03/05  

 

A Guide to Clicker 4 

Page 1 
Copyright © CALL Centre 2005 

CALL Centre 
University of Edinburgh, Paterson’s Land, 
Holyrood Road, Edinburgh, EH8 8AQ 
Tel: 0131 651 6236 
http://www.callcentrescotland.org.uk 



 

Page 2 

 



 
 

Contents 
 
 
 
 
 

Clicker 4: An Introduction for PC and Mac 3 

Clicker 4: Using Graphics and Video 14 

Clicker 4: Talking Story Books 19 

Clicker 4: For Language and Communication 25 

Clicker 4: To Support Reading and Writing 29 

Clicker 4: Handling Files and Folders 32 

Clicker 4: Using with Switches 37 

Clicker 4, Wordbar and ClozePro Grids: Downloading onto your PC 48 

Clicker 4: Shortcuts (Mac) 52 

Clicker 4: Shortcuts (PC) 53 

 

Page 1 



 

Page 2 



Clicker 4 
An Introduction for PC and Mac               

Quick Guide
  
Updated 03/05 

 
 
Why use Clicker 4? 
� It can provide beginning readers and writers support in writing through the use of word 

lists by using whole words and words in the context of sentences. 
� A well organised grid can structure a learning task. 
� It can make the pupils more independent as there is no need to rely on anyone else for 

support. 
� High quality images can be used in the grids, thus enhancing the relevance and quality 

of materials used in the classroom. 
� Grids can enable the children to participate in learning activities that they would 

otherwise not be able to do. 
� The on-screen grid can be an alternative keyboard for a learner with a coordination 

difficulty. 
� Grids can be scanned and used by switch users. 
� Talking Story Books (fact or fiction) can be made that are relevant and age 

appropriate. 
� Grids can be used to support a wide range of curricular areas.  
� Grids can be used for fun activities such as quizzes to consolidate learning. 
� Cells can contain sounds or can be set to speak. 
� Grids can be colour coded to provide additional support for a task. 
 
 
Practical points for grid creation 
 
☺ Become familiar with the software to create the grids. Find out the limits of the 

program. Will it actually do what you want it to do? This will avoid disappointment and 
time wastage. 

☺ Look at the example files that go with the program (and ones you have downloaded) to 
get ideas.  

☺ If you wish, use a blank paper grid to plan your grid.  
☺ Print out some of the template grids and photocopy them to use for planning. 
☺ Prepare a test grid that is simple so that you can get to grips with the program.  
☺ Use the tutorial to learn about and practice some of the techniques.  
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☺ There is a wealth of clip art available so you do not need to be an artist. SEMERC and 

Sherston both do excellent collections of clip art relating to the curriculum and several 
reading schemes. You can also download clip art and pictures from the internet. 

☺ If you use PCS symbols (Boardmaker) purchase the CD of PCS symbols from Cricksoft 
to use in your Clicker grids. 

☺ Learn how to 'Manage the library' so that you can specify which pictures / graphics you 
want Clicker to use. 

☺ Consider the design of your grid carefully. Do not overload it with information. White 
space is important. Print size and font are important. 

☺ Be aware that learners can become involved in the designing of the grids. 
☺ Think of sensible names for your grid as you may need to be able to retrieve them at a 

later date for use with other pupils. 
☺ Be consistent. If you use areas for delete, enter, print or another common function on 

more than one grid, keep it the same size, in the same place and use the same word or 
icon. 

☺ If you are colour coding the grids be aware that if, for example, you are using a 
particular colour to indicate a word is a verb then the same colour should be used in any 
other grids. 

☺ If you have access to the internet there are Clicker grids available to download - 
www.clickergrids.com - use as they are or as a basis for your own. If you prefer, these 
are also available on CD's from Crick. 

 
 
Getting Started 
 
If you are completely new to Clicker then one of the best ways of seeing the wide range of 
what it can do is to try it some of the examples before you start making your own grids.  
 
Loading the program (PC) 
To start Clicker4, double click on the icon on the desktop or go through the Start menu 
and then All Programs and look for the  
 
Clicker 4 folder  then the Clicker 4 program  
 
 
 
Loading the program (Mac) 
To start Clicker4, double click on the icon on the desktop or go to the hard disk and look  
 
for the Clicker 4 folder then the program.   
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Log on 
When you see the Clicker4 log on screen select none and then 
click OK. 
 
 
 
 
 
 
When you log on as ‘none’ you will be taken to the Clicker4 Home 
Grid.  
 
 
 
Clicker can be customised for different users, e.g. different font size or speech settings. 
You can set up a user name for each person and change the preferences while logged on as 
that person. When that person logs on their individual settings are loaded. Different users 
have their own Home grids so that they only have access to what is appropriate for them.   
 
Using a grid 
 
When in Clicker a single click will open a folder, file or grid.   
 
Click on See the Examples go to Sentence Building then Simple Sentences and finally 
Sentence1.   
 
ClickerWriter  
 
The top half of the screen shows  
ClickerWriter, which is the writing area;  
 
the bottom half displays the grid.  
 
 
 
 
Right click (PC), Ctrl click (Mac) to listen to the words; 
Left click (PC), Click (Mac) to put them into the writing area.  
 
The default word processor is ClickerWriter but you can choose another one using the 
Grid menu. Select Grid Properties, Send to tab, click in button beside Send to other 
application then Browse to locate your chosen word processor. 
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Entering & editing text in a cell 
Shift left click (PC), Shift click (Mac) to enter/edit text.  Edit the top line of cells to 
make a new sentence.  Now click on the cells to enter the sentence into the word 
processor. 
 
 
Grid appearance  
Cell colours, grid colours, fonts and font colours can all be 
changed. 
 
Shift right click (PC), command click (Mac) on a cell to get 
the Cell properties window. 
 
You can type in new text or choose a different graphic in the cell properties window.  It is 
also possible to take the borders off the cells or make them transparent - the background 
colour (or graphic if you used one) will show through. Experiment with changing the 
colours, fonts etc 
 
Printing grids and documents 
Go to the File menu and down to Print Grid.   You may wish to select Landscape rather than 
Portrait, depending on the grid.  If you select Print Document then the writing area is 
printed out. 
 
Keyboard 
You can use the keyboard to type as well as using the text in the cells. You may wish to use 
a grid to offer an extended vocabulary to support writing but have the user key in the 
rest of the text from a keyboard.   
 
Clicker Writer is set to speak the sentence when punctuation is added at the end of a 
sentence. This is very good to reinforce the importance of ending a sentence with a full 
stop.  Make sure you add one to your grid if the user is not accessing the standard 
keyboard.  
 
Tutorial 
Clicker 4 has a tutorial which is accessed by going to the Help menu and selecting Clicker 
Tutorial ...  
 
This takes you through a range of skills and techniques and is worth a look. 
 
For more help press F1 and this takes you to the Clicker Help topics.  
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Making a Clicker 4 grid  
 
Load Clicker 4 (PC - Start > Programs > Clicker 4; Mac - in Clicker 4 folder on hard disk). 
 
Log on dialogue box appears - click on (none) – the name you are 
logging on as for this exercise. 
Click Okay. 
 

 
The Home Grid opens 
 
Click on Make a Clicker Grid 
 
 
 
 
Templates 
The templates window will open giving you a selection of different types and sizes of 
template to choose from. For this task click on the Word Grids Tab and select Words4 
then OK. 

 
 
(PC)  (Mac) 
 
 
 

 
 
The word grids are set to send to Clicker Writer. 
 

 
 
 
A blank grid opens along with Clicker Writer, Clicker’s own 
word processor. 
 
 
 

 
You are now ready to create a grid using the blank grid. 
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To enter text into the cells 
 
Move the pointer to the first cell. Hold down the shift key and click (PC - shift left click, 
Mac - shift click). You can now type in the text for that cell. 
 
Press the tab key to move to the next cell. Type in the text for that cell. 
 
Continue until you have completed the cells (or those that you wish to fill in) then press 
Return. 
 
The cells should speak the text contained in them when the right hand mouse button is 
pressed (PC) or control click is used (Mac) 
 

 
 
 
 
 
 
 

 
To save your grid 
It is good practice to save your grid from the very early stages of setting it up.  
 
Click on File 
Select Save Grid As... 
 
 
 
 
 
In the save grid dialogue box locate where you want the 
file to be saved and give your grid an appropriate name. 
 
 
 
 
Carry on filling in the grid - keep saving it regularly by selecting Save Grid and, because 
you have already given the file a name, the file will be updated. 
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How to capitalise the next letter following a full stop in a Clicker 4 grid 
 

• Make your Clicker grid and put a full stop in the required cell. 
 
• With your pointer on the full stop cell, hold shift and right click (PC) or hold down 

command (the one with the apple on it) and click the mouse button (Mac). 
 
• You will see the Cell Properties window : 
 

 
 
 
 
 
 
 
 
 
 

 
• Click on the Send tab and the following window appears : 
 
• Near the bottom left of the screen 

you will see a wee square beside the 
words “Capitalize next letter”. 

 
• Click in the square – it should 

now be ticked. 
 
• Click on OK. 
 
 
 
 
 
 
• Now, when you finish a sentence using the full stop in the grid, the first letter of the 

next sentence will automatically be capitalised. 
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To Link Grids 
When you are creating grids to be linked it is important to leave a cell available to link one 
grid to another.  
 
Plan your set of grids carefully.  
¾ Is the link cell always going to be in the same place on each grid? 
¾ Are any other cells going to be common to all the grids? 
¾ Think about setting up a template grid which can be easily edited. 
¾ Are you going to colour code the grids or cells? 
¾ Is it appropriate to look at the grids being produced in other classes - should they be 

standardised? If you have all verbs in green but the next class has prepared verbs in 
yellow the value of the colour coding may be lost. 

 
Prepare the set of grids first 
When you are making sets of grids it is important to keep them together in one folder. 
  
Create a new folder 
From the Clicker 4 Home Grid click on the Clicker Explorer icon.   

 
On the Clicker Explorer toolbar click on 
the New Folder icon 
 
 
A folder will be added to the list called 'New Folder'. The name is highlighted. Type in the 
name for your folder and press Return/Enter.As the folders are sorted alphabetically it 
will move to its correct position in the list. 
 
Click on the Home Grid icon and either click on Make a Clicker grid or go to the file menu 
and choose New Grid.  Choose the grid you want from the templates or make a new one. 
Put in the text, graphics and/or photos you want in the cells. (More on graphics later.) 
 
Remember to save your grid regularly (File > Save Grid As…) then use Save Grid to 
update the grid. 
 
Naming grids 
If you are creating a set of grids to be followed in order (e.g. for a storybook) save the 
grids using consecutive numbers such as my story1, my story2, my story3 etc with no space 
between name and number.   
 
The forward and back buttons will then automatically load the 
next or previous numbered grid.  
 
If the grids are not dependant on a sequence then you need to make the link yourself. 
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To make a link  
Open the Cell Properties dialogue (PC – shift, right click on the cell, Mac - command click).   
 
Click on the Open grid tab then Open this Grid button.   
 
Click on Browse, locate the grid to be opened and double 
click on it or type in the name of the grid, then 
 
Click OK 
 
 
 
Deleting, Adding, Moving and Resizing Cells 
 
Deleting cells 
Select the cell(s) to be deleted (PC - Ctrl left click, Mac – Ctrl Command click) 
Go to the Grid menu, down to Delete and across to Delete cell. All cells that have been 
selected will be deleted. 
 
Adding a cell 
Go to the Grid menu, down to Insert and across to Insert Cell 
A new cell will appear 'stuck' to the mouse pointer. Click in the grid to place the cell. It 
can be moved if it is not in the right place. 
 
Moving a cell 
Hold down the Alt key and when the mouse pointer is inside a cell the pointer will show as 
crossed arrows. The cell can now be dragged into the required position. 
 
Resizing a cell 
Hold down the Alt key and move the mouse pointer to the bottom right of the cell and it 
will change to a two headed arrow. The cell can now be resized by dragging on the corner 
when the two-headed arrow is there. 
 
User Preferences 
 
When you are logged on as a particular user 
various preferences can be set for that user.  
 
Go to Options menu (PC) [Edit menu (Mac)] and 
select User Preferences. 
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Instant Pictures.  
Use this to set  
• whether or not you want the pictures to appear in the writing window 
• whether or not you want pictures in the cells 
• which pictures (graphic libraries) you want to use (or if you want to manage the 

libraries). 
 
Speech  
This enables you to set when speech is heard, to choose the voice, and set the speed and 
pitch for Clicker Writer and the Grid. Try these out as they can make a difference. 
 
Toolbars  
This is where you can customise the look of the Writer, Grid and Explorer toolbars.   

• Large tools and Small tools lets you change the size of the tools on the Writer, 
Grid and Explorer toolbars.  

• No tools removes all tools from the Writer, Grid or Explorer toolbars. 
• To add or remove individual tools from the Writer or Grid toolbars, click on the 

tool you wish to add or remove. When the tools are indented they will appear on the 
toolbar.  

• Check ‘Include Text’ to place the tool name beneath the tool on the Grid toolbar. 
 
Spellchecker  
This tab allows you to set up how you want the spellchecker to appear and which list of 
words to use – go to F1 Help topics and type Spellchecker in the index for full information 
on this feature. 
 
Included in the Spellchecker tab is Pictures. Choose here whether to have pictures in the 
Grid only, in both the Grid and Writer, or none at all. 
 
Pointers (Cursors on Mac) 
This allows you to choose a different pointer for the grid.  Pointers can also be set for 
individual cells – e.g. use the Happy face pointer when the pointer is on the cell which is 
the correct one to use at that time. 
 
Other allows for a range of different options to be set. 

• Default font enables you to select a font and size which becomes the default font 
used in all new Clicker Writer documents and new Clicker grids. 

 
• Editing and saving options let you  

o Trap mouse: this option [not available in Mac version] is provided to prevent 
the user from making any unwanted actions outside the Clicker 4 grid. The 
mouse pointer is trapped inside the grid. To untrap the mouse, Shift-Right 
Click on the Clicker Grid. 
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o Disable easy editing prevents any grid editing with the keyboard shortcuts. 
o Disable saving of grids prevents any grids being saved to disk. 
o Automatically save grids automatically saves the grid on exit. 

 
• Miscellaneous 

o Use simple Save dialog when saving documents. This option is mainly for 
Switch users enabling them to save their own Clicker Writer documents. All 
that opens when the user chooses Save Document As... in the File menu is a 
box enabling them to type in a name. The document is saved to the current 
folder. 

o When adding a cell graphic, change action to 'Send graphic'. Check this 
option to force Clicker 4 to automatically set Cell Properties: Send to 'Send 
graphic & text', so when adding a graphic, it will always be sent to the word 
processor. 

o Automatically go back to previous grid after using Wordlist grid. This 
sets Clicker 4 to always take you to the previously used grid immediately 
after a cell has been clicked on in a Wordlist grid. 

o Use simple Wordlists.  With this option checked, Clicker uses the simple 
wordlist set designed for younger users when the Wordlist icon is clicked on 
the Grid toolbar. 
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Clicker 4  
Using Graphics and Video 

Quick Guide
 

Updated  03/05

 
One of the strongest points for using Clicker 4 is that material can be personalised for a 
particular pupil or group of pupils, therefore making the work more motivating. Clicker 4 
will take various types of graphics including digital pictures and graphics for reading 
schemes such as Oxford ReadingTree and Wellington Square. Clicker will also run video 
files in avi format.  
 

Inserting pictures and other graphics  
Open up Clicker 4 and then Click on Make a Clicker grid and choose ‘Sentence Building’ and 
‘I like 1’. This is a really good example of a grid that would need pictures to fully support 
the learner.  Decide on four pieces of fruit/drinks/activities that you want to use. 
 
To add a graphic 
PC – Shift right click while pointing at cell; Mac – Command (apple) click on the cell.  
This will open up the Cell Properties  

 
 
 
 
 
 
 
 
 
 
 
 

Type the name of the picture you want and then click Instant Picture. If there is a 
picture with this name it will appear if the box. If you click Instant Pictures again there 
may be other pictures of the same name. Click on OK to insert into the cell.  
 
Insert a picture from My Picture or another program  
If you don’t see any that you like or you have a picture you specifically want to use then 
you need to manually select the file. 
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Select the cell and open up cell properties as before.  
 
Now instead of clicking on instant picture, click directly above on Graphic. This will take 
you into the graphic set that comes with Clicker CPL graphics.  
 
From here you can search through any of 
the categories to find the picture you 
want.   
 
Select the picture and it will be placed in 
the cell.   
 
 
 
 
 
 
 
 
If you wish to use a graphic stored 
elsewhere then you need to know where 
the graphics are stored in the computer. 
 
Use the drop down menu next to ‘Look in 
CPL graphics’ and locate the folder. 
 
 
Now you can search through your files to 
find the graphic you want.  
 
 
If you are going to use digital photographs then it’s a good idea to keep them in My Photos 
or to create a similar file on the Mac.   Sensible file management will make life a whole lot 
easier. 
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Managing pictures and libraries in Clicker  
 
When you locate where the pictures are stored, there might be rows of files and maybe 
some individual photos. Double click on a file to open it, click on the photo you want to 
highlight it, and then click on OK. Your photo will then appear in the preview window in cell 
properties window in Clicker. Now you can type the text you want to appear with the 
photo, click OK and the photo and text will appear will in the cell. 
 
Another way is to use instant picture in cell properties. You can set up all the photos and 
clip art in your computer to be accessed through instant pictures.  
 

 
Go to Options in the toolbar 
Then User Preferences  
The user preferences screen will appear. 
 
 

o connect up the photos and clip art in your 

he 

T
computer make sure Instant Pictures is the 
front screen and click once on Manage 
Libraries. This will open up a list of all t
libraries you have already registered, to 
register a new one just click on Register 
New Libr 
 
 
 

 
The Picture Library Wizard will now take you 
through the steps. 

1. Give a name to the library e.g. PCS symbols 
or ORT Clip Art  

2. Browse for folder through the computer, 
click to highlight, click OK. 

 
 
On the instant picture screen in user preferences, look at Graphics library and make sure 
all the boxes have a tick in them.  
 
There is a folder called ‘_My Pictures’ within the Clicker folder on the ‘c’ or hard drive, 
you can copy or just drag pictures into this folder. This folder is automatically linked to 
the instant pictures and you don’t have to manage it.  
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Setting up Clicker as a symbol processor.    
 
As before, open up Clicker 4 
and log on as none. Go to 
Options and then User 
Preferences. 
 
 
 
 
 
Make sure that Instant Pictures-As-You Type 
is ticked. Click on Mayer Johnston PCS in the 
graphics library and using the arrow up, click 
till PCS is at the top of the list. Deselect all 
the others: this means that Clicker will only 
use PCS symbols for the words that you type 
in. Click on OK. 

-

 
 
 
 
 
 
If you wish to only have ClickerWriter and are not using 
the grid, you need to remove the grid for Clicker 4. On 
the computer keyboard, press the F2 key (pc) or from 
within Clicker Go to Grid and then Hide/ Show Grid  
 
 
 
 
 
Now Clicker will have a blank page and as you type symbols will appear for the words.  
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Using Video Clips in Clicker Grids 

 
Clicker 4 can play video clips that have been saved as .avi files. The Digital Blue Movie 
Creator uses this format so any clips can be saved and exported as .avi files and stored on 
the hard disc or other suitable storage device. Some digital cameras can take short movie 
clips and, depending on the make, these may be .avi files and can also be used.  
  
.AVI Video clips  
These can only be added to cells – not to text or graphic boxes such as those used in the 
Bookmaking templates. 
 
Load Clicker 4 and create (or Open) the grid to be used. 
 
Shift-right click on the cell that is going to play the video clip and open the Cell 
Properties box. 
 
Click on the Sound and Video tab. 
 
 
Click on the button beside Sound 
or video file  
 
 
Click on Browse 
 
Find the video clip to be played 
and double click on it. Its 
pathname (the information that 
the program needs to find the 
file) will appear in the Sound or 
video box. 
 
To make sure the video plays in 
the correct place on the page click on the play button.  
 
The Video Position box appears and you move it over the cell where the video is to be 
played – resize it as well if necessary – then click on Play to make sure it is in the correct 
place. When it is correctly positioned click Okay. 
 
You can put a graphic or photo in the cell to indicate the content of the film. Now when 
the cell is clicked the film will play. 
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Clicker 4 
Talking Story Books 

Quick Guide 
 

Updated       03/05 
SO 

 
To make a Talking Story Book you can use one of the Bookmaking Templates that come 
with Clicker 4. 
 
Start Clicker 4 
Go to the File menu and select New Grid 
 
The templates window opens 
PC: Choose the Bookmaking tab 
Mac: from the drop down menu under Templates choose bookmaking 

 
 
Layout 3 has a picture at the 
top with text underneath and 
can make a good Front cover.  
 
 
  

 
In layout 1 the screen is divided into two main areas and 
some buttons.  The left-hand side is for the picture; the 
right hand side is for the text. 
 
Choose the layout required and click OK. 
 
Go to file and Save Grid As… 
The Save Grid box appears.  
Create a new folder: 
 
PC: Click and call the new folder My story. Double click on the folder you have 
just made to open it. Save the grid as Start. 
 
Mac:  Click the create new folder button. Type in the name of the folder (My story). 
Double click on the folder you have just made to open it. Save the grid as Start. 
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NB: The name of the folder should be relevant to the story you are doing e.g. Our 
Visit to the Park, My Morning Activities, My favourite toys  
Adding a picture 
 
Shift click in the graphic (left) box 
Click on the open file icon  
PC:   Mac:  
 
 
Find the picture you want to use – it may be one from the CPL Graphics library or you can 
use any graphics or photos on the computer or that you have on an external storage device 
(e.g. floppy disk, pen drive, CD). If you do use pictures from an external storage device it 
is essential that you remember to Organise your files on each page of the story after it 
has been saved.  See page 5 for info on how to do this. 
 
 
For this activity use the CPL Graphics 
 
Select the required picture file and choose open 
(or double click on the picture file). 
The picture will be inserted into the graphic box. 
Go to the file menu and choose Save Grid – the file 
will be updated 
 
 
Adding Text 
 
Move the pointer to the text box then 
PC: Shift left click, Mac: Shift click  
A tool bar and cursor appear at the text box. 
The tool bar which appears at the top of the text box (PC) or in the text box (Mac) has 
some of the features of a word processor and can be used accordingly. 
 
PC:  
 
Mac:  
 
 
Type in the text for your story 
Go to the File menu and choose Save Grid – the file will be updated 

 
You have now completed the first page. 
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The second page is made in exactly the same way. 
File > New Grid 
Choose Bookmaking template and layout required 
Save Grid As….  (This time you should be taken straight to the folder you have just 
created and where Start has been saved) 
Call the grid 01 
Fill in the picture and text boxes 
 

Remember to save the grid as you go along! 
 
Do the same for the rest of the pages of the book and call the pages 02, 03, 04 and so on. 
If you want to use an animation it has to go in a text box – it animates when the sound is 
played. You can buy a CD with Animations from Cricksoft (www.cricksoft.co.uk) 
 
You can choose to change the size and position of the picture and text boxes (Alt or 
option held down while pointer is on the cell or at the bottom corner of the cell). See the 
Clicker 4 Shortcuts page for a reminder of the keys to hold and press to change the size 
and position of graphic and text boxes. 
 
You may like to change the background colour of the text box or the font and font size.  
Shift click in the text box to get the textbox toolbar. 
 
To change the background colour select the Background Colour icon. 
 
To change the font, font size and colour and click on the Font icon  
 
You can make take away the borders, (click on the Borders icon to toggle the box 
outline on or off) 
 
Try experimenting to make the storybooks as interesting as possible and accessible to the 
pupil(s) you are working with. 
 
Sound  
 
Make sure you have a microphone attached to the computer and the sound is working. 

The sound icon at the bottom of the page automatically links to the text box. This 
will give you computer speech.   

 
 
To record your own voice, make sure the pointer is over the sound icon then open cell 
properties (PC: shift right click, Mac: command click) and click on the tab Sound and 
Video.  
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Clicker 4 speech defaults to software speech so change by clicking on the radio button 
beside Sound or Video file.  

 
 
 
 
 
 
 
 
 

Now click on record and start speaking clearly and slowly.  
 
PC: red text appears in Sound or video file box as the recording progresses.  
When you have finished recording press stop.  
Click OK to finish.  
 
Mac: in the pop up box click on record and speak clearly 
When you have finished recording press stop.  
Click Save to finish.  
 
Linking the pages together 
 
If you have named the pages 01, 02 etc, they should link automatically. If the pages don’t 
link automatically you have to do so manually. You do have to make the link from Start to 
01. Before you begin make sure you have the Start grid for the book open.  
 
To link from the Start grid to 01 put your pointer on the arrow  
in the bottom right hand corner   
 
Open up the cell properties (PC: Shift right click, Mac: Command click) then click on the 
tab called Open Grid 
 
This is where you choose the grids you want to link, and 
there are different ways you can link the grids.  
These include: 
 
Open this grid – you decide what grid you want to link 
Open a grid from random – Clicker chooses any grid 
from the ones you highlight. 
Home grid – opens the grid you have called home in that folder. 
Next grid - opens next grid in a numbered sequence 
Previous grid - opens previous grid in a numbered sequence 
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For this book, click in the radio button beside Open this grid and then click on Browse 
(PC) or Select (Mac), now you should see all the grids contained in the folder.  
 
Click once on the grid you want to highlight it (for this 
part of the activity it will be 01)  
 
Click Open to make the link. 
 
From the Start page, when you click on the arrow it 
will move to 01.  If you have named the pages in sequence they should link automatically 
(01, 02, 03, 04 ……..).  Check that it works. If there is a problem you can link them by using 
the same procedure and choosing the radio button beside Next Grid. 
 
If you want to go back to the beginning of the story from the last page then you can link 
the right hand arrow to the Start grid. 

 
Organise files 
 
If you want to put the story onto another computer all the files 
used to make the grids for the book need to be inside the My 
story folder, e.g. all the graphics, all the sounds, all the buttons 
etc 
 
To do this chose the option in the file menu to Organise files 
on each page of the book. 
 
The files that are at present outside the folder are on the box 
on the left hand side.  Click on the copy button in the centre of 
the two boxes and these files are copied into the folder. 

 
 
 
 
 
 
 
 

This has to be done for every page. 
 
If you regularly create grids to be used on other computers then it is good practice to do 
this for all the grids as you make them - so when you have completed a grid (or page) and 
saved it remember to Organise your files. 
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Special type of folders 
 
In Clicker 4 you will see some folders that have a red top    
 
 
These folders are called application folders and when you click on this type of folder it will 
automatically look for a grid called start and launch it.  
 
To change a folder to make it one of these special ones you have to rename it and add an 
exclamation mark at the beginning of the name of the folder e.g. !Our Visit to the Park, 
!My Morning Activities. 
 
To rename a grid in Clicker 4 hold down the shift key and click on the folder. A menu 
appears and you type in the exclamation mark before the required name. 
 
When you see the folder in Clicker Explorer it will now have a red top and when you click 
on it the first page of your story will automatically start. 
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Clicker 4  
for Language & Communication                 

Quick Guide 
 

Updated    03/05 
SM 

 
Clicker 4 is a valuable tool for stimulating, developing and supporting language development in 
general, at all stages, with a wide range of different types of pupils. It is also ideal for supporting 
all sorts of curriculum-based work on language and communication. Its obvious key qualities in this 
respect are: 
 
• picture support for written text, for pre-readers, emerging readers and non-readers. 
• voice output support for written text for pre-readers, emerging readers and non-readers. 
• direct access to the meaning of words and sentences without the user having to get tangled up 

with spelling or the mechanics of typing. 
• switch and scan access for severely physically involved pupils. 
 
Other qualities are: 
• Because it is ‘framework’ program, it can ‘grow with’ the child just by adding new and different 

vocabulary and tasks. This is ideal, as they (and you!) are not then chopping and changing about 
between a whole lot of different programs that all work differently and have a different 
‘interface’ to get used to. You are using the same program that has become familiar and easy to 
use. 

 
• Apart from/as well as picture support, it can provide other visual clues for children with 

specific language disorders – eg. spatial location and colour coding. 
 
• Using Print Grids (>File Menu): Clicker 4 can be used to develop and print out paper-based ‘low 

tech’ picture and symbol based materials. For example; name tags, labels for objects around 
the room/school, games (lotto, pairs etc.), topic charts (eg. weather), worksheets (eg. draw a 
circle round all the ones that….), pictorial timetables, behaviour management schedules (‘I’m 
working for……’; ‘I’m waiting for……..’ ), TEACCH materials (colour-coded work schedules). 

 
• Using Instant Pictures as you Type (>User Preferences>Options Menu) - especially with PCS 

symbols installed – Clicker 4 can be used to quickly produce inclusive, accessible written 
materials that have picture and symbol support for text, (eg. story about class outing, shopping 
list, ‘Things I must remember to bring to school tomorrow’ etc.) 

 
• It can act as an introduction and training programme in the development of switch and scan 

skills (while also working on relevant language material). 
 
• It can act as a ‘trainer’ for use of a full-scale augmentative communication system for children 

with little or no functional speech. 
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• As it can be used on computer, it may motivate and engage the child in a way that ‘silent’ paper-
based communication materials may not. 

 
• As school staff become familiar with the wide and varied uses of Clicker with all sorts of 

pupils, everyone benefits. Speech, language and communication impaired pupils are likely to use 
it more intensively and have more positive learning experiences with it than they might with 
‘black box’ technology’ that relies on the (possibly infrequent) visits of a speech and language 
therapist to introduce, teach and support. 

 
Clicker 4 with symbols 
Clicker comes with its own set of graphics (CPL graphics folder inside the Clicker 4 folder) which 
are quite nice and can be supplemented with any other pictures you want (save these into the My 
Pictures folder, inside the Clicker 4 folder).  
 
However, this is not a wide enough range of pictures to provide comprehensive communication 
vocabulary for a child with little or no functional speech. It is recommended that for this kind of 
child use, additionally, Mayer Johnson Picture Communication Symbols (PCS) be installed. 
 
Installing PCS 
Even if you already have BoardMaker software, with the PCS symbols, you cannot get the PCS 
symbols out of BoardMaker to use with Clicker1. You have to install an additional set of PCS 
symbols on to your computer. These come on a CD and need to be installed inside the Clicker 4 
folder, registered and ‘managed’ as a Clicker library, so that the program can ‘find’ the symbols 
when it is in ‘Instant Pictures’ (in cells, or as you type) mode. (see CALL Centre Quick Guide 
“Managing Pictures and Libraries in Clicker”) 
 
On the CD the PCS symbols are organised in two ways – by topic category (‘Cat’ folder), and in 
alphabetical order (‘Alpha’ folder). The instructions say you should install the ‘Cat’ folder for some 
reason, but in practice it tends to be much more useful to install the ‘Alpha’ folder. 
 
Clicker 4 as a communication aid? 
Clicker 4 is perhaps not the perfect voice output communication aid, so may not be the system that 
is finally recommended as a specific child’s personal communication aid. But it is an incredibly 
valuable system for getting started with, and for introducing, practising and building up all the 
skills needed.  
 
If it can be demonstrated (on the classroom computer) that a child is competent in all the basic 
skills involved with operating a voice output system, and has achieved success with this,  
then it is much more likely that agreement will be reached quickly to provide funding to buy a more 
complex and powerful aid (and expensive!) personal voice output communication aid. It is also more 
likely that the child will succeed with an expensive and complex communication aid when it arrives! 

                                                 
1 Technical Note: 
The symbols in BoardMaker are in a special Bitmap format, while Clicker 4 can only work with graphic in Windows metafile 
(.wmf) or .jpg format.  
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Setting Clicker 4 up for communication 
 
Right click – speech preview.  
Unless you have deliberately changed this, all cells in a grid will automatically be set to the 
‘default’ setting, whereby if the user right clicks on the cell it will highlight and speak out its 
contents, without sending anything to the document above. This allows the child to check what a 
cell says before choosing it.  
 
This is useful especially on text-only grids, for children who are reading a bit but just want to 
check the odd word. It is not so useful to younger children or those with complex difficulties. (For 
them, we will tend to be using picture/symbol support in the cell along with the written word 
anyway.) 
 
Unfortunately, switch and scan users cannot access this feature directly but can have cell 
contents read as they scan if the right button sound is selected to software speech (with the text 
to be spoken in the box) and the Scan sound  in Access is Play right mouse button sound. 
 
Speech on Selection 
For speech and language impaired users, we generally want Clicker set so that the word/picture 
speaks out loud immediately the child clicks on it with an ordinary left mouse click, or selects it 
with their switch. 
 
This is different from the default setting, so you have to make a few changes. 
 
There are two separate areas to think about –  

(1) the speech output from the ClickerWriter document (if you are using one) - you can set 
it up to speak from the document end, in one go (quicker).  

(2) the speech output from the Clicker grid - you can set it up to speak from the grid, cell 
by cell. 

 
It depends where you are starting from and what exactly you want to do, which is the best route. 
Whatever you do, though – don’t do BOTH – or your grid will say each word twice, which is 
confusing! 
 
1. Document  
 
If a grid is ready-made (eg. downloaded from 
Clicker Grids for Learning), it is quicker to 
change the speech setting for the whole 
document, in one go.  
• Open Options Menu> User Preferences> 

Speech (tab at top).  
• Click to tick the bottom three of the four 

available options.  
• Click OK. 
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2.  Grid 
 
Left click – sound output. 
When the user left-clicks to select a cell, the default setting in Clicker is for the word (and 
possibly picture) to be sent to the ClickerWriter document, but with ‘No sound’.  
 
If you want to change the speech setting while you are building a grid, you can do it as you set up 
each individual cell.  
 
This is especially useful if you want the button to say something different to the word that is 
written on it. To do this –  
• Select cell (shift + right click) 
• Select Sound and Video (tab at top) 
• In the Left Button section, click in the button for Software Speech (the message that is 

written on the cell will pop into the box. Usually that is what you want. Click on Play to hear it – 
check it sounds right. Then Click OK 

• If you do NOT want the button to say out loud what is written on i , then click in the button 
for Software Speech as before and type into the box exactly what you DO want it to say. For 
example, the cell might have ‘apple’ written on the screen, but you might want it to say out loud 
“I would like apple juice please’. Click on Play to hear it – check it sounds right. Then Click OK 

t

• Test it by clicking on the cell and checking that it speaks out as expected. 
 

Pronunciation 

 
Sometimes words are just not pronounced properly by the speech synthesiser – especially proper 
names. You can fix this.  

• Type in the word you want to fix, eg. Mhairi. 
As it is a name, it will know that it is not in the 
dictionary, so will invite you to add it. Click on Next 

 

• A screen will come up that shows the spelling at the  
top, and two further boxes below. Type ma ree     
into the second box down.  

• Hit Play to hear how it sounds.  
• If you don’t like it, try other combinations, eg. mahree  

Sometimes you have to play around with different spellings, and use combinations of letters that 
are not ‘real words’ and spaces to separate out bits of words (acting as a pause).  For example, edin 
burruh for Edinburgh.  

• When it sounds satisfactory, Click Finish 
• Click No (to email to Microsoft) 
 
If you have a word that you cannot ‘fix’ in this way, you may want to try building it up from scratch 
phoneme by phoneme (or by adapting little parts of the phonemic make-up). Click on Phonemes to 
see the list, and type in any changes you want to try  
 
Avoid this if possible – it can be very fiddly and time consuming! 
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Clicker 4 
To support reading and writing                 

Quick Guide
Created 11/03 
Updated 03/05 
 PN 

 
Clicker supports reading and writing at all levels in many ways, but this Quick Guide 
concentrates on some of the program’s features which are particularly helpful for 
students with dyslexic-type difficulties. 
 

Reading 
1. Start Clicker and click Start Writing. 
2. Click on the ‘Hide Grid’ icon at the right hand end of the ClickerWriter toolbar to 

hide the grid.  
3. ClickerWriter saves and opens HTML documents, so click File > Open and try to find 

one on your computer to open as an example. If you don’t have a suitable document, 
open some text in another program, copy, and then paste it into ClickerWriter. 

4. Select the text and click the coloured ABC button and choose a suitable font, size and 
colour. 

5. Highlight the text you want to read, then click on the speech bubble at the right hand 
side of the toolbar. You can also click on a word at a time to hear it. 

6. Adjust the speech options: click Options > User Preferences > Speech; and change the 
voice and speed. 

7. If words are not pronounced correctly, click Options > Pronunciation to change it. 
 
 
Speak as you type 
1. Set ClickerWriter to speak each word and each sentence as it is typed in – select 

Options > User Preferences > Speech and tick Speak each word as space entered 
and Speak each sentence as full-stop entered. Type a sentence to hear the speech. 

 
 
Picture support 
1. Set ClickerWriter to give pictures as you type – select Options > User Preferences > 

Instant Pictures and tick Instant Pictures-As-You-Type. Type a few words to see 
pictures come up. Note that you don’t get pictures or symbols for every word – only for 
words which have a matching picture in the Clicker libraries.  
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Spellchecker 
1. Type a few mis-spelled words – e.g. Wen I rite teh comptr toks wich I yooshaly lik. 

Then click the ABC-tick button on the toolbar to do a spellcheck. A spellcheck grid will 
appear with suggestions for each mis-spelling.  

2. Listen to the words in the grid by clicking with the right mouse button.  
3. Change the mis-spelling for the correct word (if one is offered in the grid) by clicking 

with the left mouse button.  
4. Note that ‘real word errors’ like ‘rite’ are not picked up. 
5. Note that the spellchecker doesn’t offer any suggestions for ‘comptr’, but if this 

happens, you would show the pupil how to play around with the speech and spellchecker 
to try and get some suggestions. E.g. Double click on ‘comptr’ in the sentence, and then 
on the ‘Speak’ button to listen to it. You might ask the pupil what sound and letter is 
missing – and hope they said ‘u’. Add the ‘u’ to the word to make ‘computr’ and then click 
on the ABC spellcgeck button again – the correct spelling will be offered.  

6. When you check ‘yooshaly’ no suggestions are made in the grid so we will add this mis-
spelling to the spelling dictionary. Click on Options > User Preferences > Spellchecker 
and then type in ‘yooshaly’ to the !New Word box, click Add Word, and then type in 
‘usually’ to the ..suggest these words box. Click OK. Now select ‘yooshaly’, click ABC 
and the correct spelling will be offered. 

 
 
Word list grids 
1. Every Clicker user (i.e. the user chosen when Clicker first starts) has their own set of 

word list grids, organised alphabetically. To see the wordlists, first show the grids 
(click on Hide Grid at the top right of the toolbar, or press F2). Then click on the 
Word List button in the grid toolbar (the one with two columns of text in it). Click on a 
word list to open it. 

2. Add some new words to the grid by holding down SHIFT and then clicking on a cell. 
 
 
Review Clicker Examples 
Click on Home in the grid toolbar, then on See the examples and have a look at some of 
the examples.  
 
Make a grid 
1. Click on Home in the grid toolbar, then on Make a Clicker Grid. 
2. Click on the various tabs (Sentence Building, Word grids) to see the type of grid 

templates available. Choose either a simple word grid, or one from the Sentence 
Building list.  

3. Change the background colour of the grid – select Grid > Grid Properties, click on 
Background colour and choose a new colour. 
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4. Add some words to the blank cells (Shift-Left-Click). You should get some pictures 
automatically added to some cells. If you don’t, select Options > User Preferences and 
check that Instant Pictures-for-cells is ticked. 

5. Add graphics to some cells by Shift-right-clicking to open cell properties, then click 
Graphics and open a graphic.  

6. Save the grid – Click File > Save Grid as. 
 
Using Clicker 4 with Penfriend 
1. Load Penfriend (version 1.02 or later) 
2. Use the Predict grid in Examples > keyboard > Predict 
3. The predicted words are then sent to the grid. 
 
To set up your own prediction grid 
1. Make a new grid 
2. To set up prediction cells 

a. Select cell 
b. Open cell dialog box for the cell 
c. Click send tab 
d. Enter the command {predict} into the send text box 
e. Click OK 

NB This only works reliably with up to 6 cells set up to predict.  
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Clicker 4  
Handling Files and Folders  

Quick Guide

 
There are 2 ways of organising files and folders. One is more or less 
file/folder structure way and the other is the special Clicker way (using
which is within the program, accessed through the toolbar above the
bottom half of the screen).  It is confusing at first.  You may need to
way to tidy up files and folders, to find them if you want to move them
4 folder or attach them to an email. Otherwise, once that is sorted
manage them within ‘Clicker Explorer’ most of the time. 
 
First step therefore might be to check out what is what at present.  
 
Ordinary way 
From the Windows desktop, double click on My Computer and then on
Windows Explorer). On a Mac, just double click to open your hard driv
what folders are in it. 
Double click on Clicker 4 folder. You’ll probably see that all the gr
perhaps also all the picture files you put in them are kicking about ‘loose’
4 folder, is that right? 
 
If so, you need to get them all tidied up into folders that are properly
find them again. You should not have any blue and red files floating 
Clicker folder (except the Clicker Home file).  

Right-click on your mouse and
Folder. (On Mac, go to File m
Name the folder ‘Frednews’ 
drag all of the files relatin
made for him in to this folde
there are no stray pictures
about in the Clicker 4 fold
tidied away into other fold
ones called ‘Crick’ and ‘Home’
alone). 
 
This pic shows my folder on 
not look exactly like this but 
only with less in it? 
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Having tidied up, now close all that up, and open/launch the Clicker 4 program. When you 
do ‘Start Writing’ and the blank screen comes up, click on the little yellow folder with the 

magnifying glass,   (next to the house icon, on the toolbar half way down the screen). 
It will open up the Clicker Explorer file structure.  
 
You will see that all the 
same files are in there, 
with the same names 
(as the folders you saw 
in the Clicker4 folder 
on the hard drive C).  
 
 
As an example, click on C4 Examples. You will see that within it there are lots of other 
folders. Each one is a grid or a series of linked grids, each with a common-sense name that 
you can easily recognise. A single click on a folder will open it up and show all the linked 
grids within.  
 
 
 
 
 
 
 
 
There may also be a pile of pictures within a folder, along with the grids. When you make a 
grid with pictures or symbols in it, you have to make sure all the pictures are stored along 
side their grids in a folder, otherwise if you move the grid to another computer, you will 
find that it has ‘lost’ its pictures. See below (“Organising Files’) for how to do that. 
 
If you are within Clicker Explorer, you CAN delete or rename files and folders and move 
them around into different folders, but you need to know how – ordinary mousing does not 
work.  
 
PC 

• On the PC, it’s SHIFT+left click to open the wee window and choose to Delete, 
Rename (or Open, Duplicate) etc.   

• It’s ALT+left click to drag/move a file (eg. to pull it into a folder). 
 
NB. You can only put things IN to folders this way, you CANNOT move them out again 
using this technique – you have to go to Windows Explorer / your hard drive again (see the 
above section) to move them out again! So plan carefully! 
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Mac 
• it’s CTRL+SHIFT+Click to open the wee window and choose to Delete, Rename (or 

Open, Duplicate ) etc.   
• It’s CTRL+SHIFT+OPTION (sometimes OPTION key is called ALT) Click to drag a 

file (eg. to pull it into a folder). 
  
To get more information about file handling within Clicker Explorer, use the Clicker HELP 
button on the Menu bar (top right), click on the 
FIND tab at the top, and then type in Clicker 
Explorer in the window. Clicker Explorer Icons is 
another useful Help page (see below) 
 
It will come up with instructions about how to 
manage files - I suggest you print these pages out.  

 
 
 
 
Now let’s start at the other end. From now on, when you are making new Clicker grids, 
remember this: 
 
Before you complete a ‘Save As’ of any new Clicker grid, you should first create and 
name a new folder to save it into. 
 
Really, it’s the ‘if you were trying to get to there, you shouldn’t start from here’ syndrome! 
It’s easiest to organise your files BEFORE you make grids – or at least the very first time 
you save a grid. 
 
Make a new grid, go to File Menu, Save Grid As and when the window comes up, instead of 
just naming the grid straightaway, click on New Folder and name THAT (an overall easy to 
identify common sense name for the whole grid). THEN name your new grid file and save it 
into the newly created folder. As you go along, with linked grids etc. after that they will all 
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get saved into that folder, all together as a package. They should then be easy to ‘find’ 
after that – whether you are looking in Clicker Explorer or by the ordinary C drive/folder 
route. 
 
Also, you can move the whole folder easily and be sure that all the bits you want are 
coming too.  
 
That’s more or less it, but not quite. One VERY important thing, if you are using pictures 
or symbols in grids.  
 
Organise Files (PC) / Organise Files for Grids (Mac) 
Often, with Clicker 4, you can move a grid or folder around and discover that you have 
‘lost’ all the pictures. Panic! Don’t panic. The answer is to get into a routine, every time you 
make a new grid, to  
• make a new folder 
• save grid into its own folder 
• Go to File Menu, then Organise Files (for Grids). It will show you all the pictures you 

have used on the left (files outside grid folder) and invite you to COPY them into ‘Files 
inside grid folder’. Hit the copy button and they will pop across. 

 
You should also do this every time you adapt a grid.  You also need to do it for EVERY page 
in a Talking Book. Once paranoia has set in, you’ll do it very time you do anything at all to 
any grid! The good news is that it’s very quick to do. If there is no need, it will tell you – it 
just comes up with what is MEANT to be a reassuring message ‘There are no files to 
organise in this grid’ (or something like that).  
 
You need to do this because Clicker does not pull the pictures out of the libraries when 
you make a grid, it just sets a path to the picture. If you move the grid, you alter the path 
and it can’t get back to find the picture. That’s why you need to make a copy of it into your 
grid folder. 
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SUMMARY 
 

The five most important things to know are: 
 

(1) You must save all clicker grids into their own folders, NOT have them floating 
about ‘loose’. 

(2) It’s much easier to create the new folder before, or as, you save the first grid 
than it to tidy all the grid bits into folders later 

(3) The folder must be inside the Clicker 4 folder otherwise the program won’t find 
it. 

(4) You must do File– Organise files for grids each time you make or change a grid 
with pictures. 

(5) If you are making linked grids, with one based on the one before, you must do 
‘save grid as’ and give the second/new grid a different name almost immediately 
(or else the AutoSave in Clicker will save your new grid over your old grid and 
lose the first grid! (Or switch off the AutoSave, which is in User Preferences on 
the top Menu bar. 
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Clicker 4  
Using with Switches  

Quick Guide
 
Updated 03/05 
 SM 

 
Clicker 4 can be accessed with either one or two switches. This means that Clicker can be 
used with pupils with physical disabilities. Switch access can also be set to provide 
auditory scanning feedback (called ‘scan sound’ in Clicker 4) if required. 
 
Switch Access 
If you are using switches for the first time, check if the switch access has been installed 
by going to Options and then looking to see if ‘User Access’ is there. If not then you need 
to get the original Clicker 4 CD and run it, making sure you tick the box ‘Install switch 
access’. You may need to get ICT services technicians to do this. (It is worth trying to 
make sure that ICT services know that they should always install Switch Access when they 
install Clicker 4 in the first place.) 
 
Creating Grids  
When you are creating grids for switch access don’t set up the access method for the 
user until the very last minute. Just set up all the grid(s) and pages the way you want them 
to be, and only change over to switch access at the very last minute before the user starts 
to work on the system.  
 
However, if a grid is to be used by a switch and scan user, you need to take this into 
account at the design stage.  

• It is easier to see and scan through cells if they are in straight lines not scattered 
all over the screen.  

• It will be quicker and easier for the user to have a smaller number of cells per page 
(if you need more, use linked pages instead of packing lots of cells on to one page). 

• Leave plenty of space between the cells, so there is room for a good thick scanning 
box to move round the outside of each cell.  

• You will need clearly contrasting colours so that a scanning box can be seen easily, so 
keep the colour scheme simple.  

• You need to be clear in advance about whether you want the user to do row-column, 
or column-row scanning (see Page 3, below) as that will affect where on the display 
you position certain word /pictures, and how efficient (i.e. fast/easy) the grid 
design will be for the user. 
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Adapting grids  
Remember that if the grid was last set up for use by a switch user, it will automatically 
save the settings and ‘wake up’ next time in switch and scan mode. You will have to pop it 
back into mouse access (options – user access – mouse pointer) before you can alter the 
grid. When you are finished adapting the grid, put it back to switch user so that it is ready 
for the user to use.  
 
 
Organising User Files  
 

Because of this automatic saving of switch access setting along 
with the grids, it is a good idea (essential!) to organise your 
different grids by user. Add the name of your switch user as a 
User and always log-in by that name from the opening screen each 
time. That means that his/her grids will be ready to use in switch 
and scan mode, but other children (or you) are not confused by 
finding themselves in switch and scan mode.  
 

 
Changing from User to User / Log In Options 
 
If you want to change from that user to another user, later, you do 
not need to Quit / Exit and close down Clicker then re-open it 
again. You can switch between users quickly and easily. Go to 
Options – Log In Options.  
(You can save ‘general’ grids outside specific users’ folder (i.e. Log 
in as ‘none’) or in a folder called ‘class’ or suchlike)  
 
When you add a User, an empty folder is created automatically for them, inside the 
Clicker 4 folder, into which all their grids will be saved. A user folder is recognisable 
because it has a plus sign  + in front of the folder name.  

 
 
 
All the necessary utilities will automatically be put into this folder for you, by Clicker.  
 

Page 38 



Setting up Special Access 
Once you have finished making the grid and are ready to set it up for the user, go to 
Options ~ User Access 
 
There are 5 different tags along the top – you will need to make settings in each of these 
sections. It may be wise to experiment and try the different settings out yourself, before 
setting the user off, so you are clear about how it all works. 
 
First click on Access Method.  
 
There are two different switch access 
methods on offer.  
 
Single switch  
Single switch access is least demanding 
physically but quite demanding cognitively 
and in terms of control: it requires good 
understanding of what is going on, good 
visual concentration, and accurate timing of 
switch presses.  
 
Two switches  
If they can possibly manage to operate more than one switch, two-switch access is 
sometimes easier for the user to understand, and it relies less on accurate timing though 
it is more physically demanding.  
 
The user has to hit Switch 1 each time, to move along from cell (or block of cells) to the 
next cell (or block). He/ she has to hit Switch 2 to select a cell (or block of cells).  
 
If regular (word) grids are used, the system can be set to scan EITHER Column first 
(across from left to right) then down, row by row OR Row first (down from top to bottom, 
row by row,) then across each column from left to right. 
 
Setting up for Switch use  
To start with, click Single Switch 
 
It’s probably better to click on ‘Restart scan at beginning…’ to start with, as this is 
easier for the user to understand, although it’s a slower method. This can get frustrating 
later on, so you may wish to unclick this later, once the user has grasped the whole 
operation, to speed up his/her selections.  
 
Scan Type  
Then click on the Scan Type tag at the top of the box. 
For now, choose Simple and Outline Scan  
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This means the scan will be a coloured frame around the outside of the cells. Choose the 
width of this frame – the exact size will depend on the size of your cells and the space 
between them. You want the frame to be as big as possible so it’s easy to see, but not so 
thick that it starts to cover up other areas on the screen. Anything between about 10 and 
25 is likely to suit – just try ‘til you get it right. 
 

Now choose the colour of your scan frame box. 
Again, the best colour will depend on the 
background colours of your grid. (e.g. red is good 
against a white background, yellow on blue is 
good.) 
 
(On the Mac, the easiest way to get a colour may 
be to use the ‘crayon picker’ (though you should 
experiment with the other methods as well.) 
 
 
 
 

� Outline scan - places a border around the scanned cell or selected cells and the width 
of this can be changed in Outline width. 

� Fill scan – as it moves along, the scan fills each cell or selected cells with a colour (that 
is changed in Scan Colour). This can be a bit confusing! 

� No scan - turns off scanning in this cell or selected cells. 
� Invert - when selected inverts the colours used in the cell or selected cells when it or 

they are scanned. Can be very confusing! 
 
Sound  
Now click on the Sound Tag at the top. There 
are two different things to be decided here.  
 
1.  What sound should Clicker make when the 

scanning box is stopped by the switch user 
to make a selection? 
Usually, the default Play left mouse button 
sound (on a Mac, this is Play mouse button 
sound) is best. That is, it says whatever the 
cell is set up to say just as it would with a 
mouse click.   
 

2)  What sound (if any) do you want while the scan box is moving, scanning through the 
cells? Usually, no sound is best (a beep may SEEM like a good idea in theory but it will 
drive everyone mad!) 
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Auditory Scanning 
 

There is one important exception. For users who have a 
visual impairment or a difficulty perceiving the cells or 
scanning box (or even just a difficulty concentrating), 
an auditory scan may be useful. To get this, you simply 
select the bottom item   
 

 
 

Play right mouse button sound  
(on the Mac, Play control + mouse button sound)  

Timings / Scan Speed 
Now click on the Timings tag at the top, and make selections from this screen. Scan or 
dwell delay is the speed of the scanning box. Select 20 to start with (The higher the 
number, the slower the scan. 10 = 1 seconds, approximately, 20 = 2 secs, 30 = secs and so 
on.)  
 
Acceptance Delay is how long the switch needs to be held down before the signal is 
picked up. 

• For users who find switching effortful or difficult, this will normally be set at 0 (so 
that even the slightest touch will operate the selection). 

• For user with a tremor, or who might brush accidentally over the switch at other 
times when they are not meaning to make a selection, you might try setting this at a 
higher number (you’ll have to experiment). You might want to try setting it at quite a 
high number (10 or above) for users who have a tendency to hit the switch 
repeatedly (to ‘lock them out’ for a while, and/or to give them time to register the 
effect of their switch press). 

 
Debounce or Autorepeat 

• Some users can hit the switch but have trouble releasing it again. You don’t want the 
system to register this as a string of unwanted repeats, so don’t set this to 0. Set it 
higher to avoid repeats.  

Many users don’t actually need either of these settings 
changed at all from the default – don’t fiddle with them 
unless you really need to (or of you do – write down what 
they were set to before you started changing them). 
These last two settings interact with each other in quite 
a complex way, so experiment with them but leave one at 
0 while trying the effect of the other, until you are 
clear which does what. If you change them both at once 
you’ll get confused. Keep a note of the effect of each 
change.  
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The last of the Access setting tag along the top of the User Access box is also very 
important.  
 
Switch Connection  
Windows PC version  

 If this is set to None, then all your settings 
done so far will not take effect.  
 
To try your settings out without actually 
connecting up the switches and working with 
the user yet, set this to the bottom setting, up 
and left arrow keys.  
 
If you are using a Don Johnston Switch 
Interface, this up and left arrow key setting 
will also work the switches.  
 

Click OK and watch your setting take effect. Use the left arrow key on your keyboard as a 
single switch to make a selection as if you were the user using his/ her switch. (Up arrow 
key will scan along if you are in two-switch setting). After testing, unless you are using a 
Don Johnston switch interface, remember to switch back to the appropriate switch 
setting for the user to use their switches. 
 
Mac version 
You can try your settings without having switches attached.  
Options Menu – User Access – Switch connection tag 
Click Don Johnston Switch Interface 
OK 
You can then use the 0 (zero) key as a single switch. (The 3 key will scan along if you are in 
two-switch setting). 
 
Note: If you are trying to use a Crick Switchbox and you can’t see it on the list of 
connection options, then you need a later version of the Clicker software - this can be 
downloaded from www.cricksoft.com but you will need the licence number to upgrade your 
copy, and if you are on a network, you will have to get IT Services to do it. 
 
Adapting User Access and scan settings  
You can alter the above settings while the scan is running – you do not need to set the 
User Access back to mouse. Go to Options – User Access and change settings as required, 
then click OK to see them in action.  
 
Once you are happy with the settings, you can connect up the switches for real.  
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Connecting up the Switches  
There are various switch connection boxes you can use. For example –  
Don Johnston Switch Interface Pro (PC and Mac, USB connection) or, for the PC only, 
Cricksoft supply a switch box that works with Clicker (but not necessarily with all other 
programs). 
  

• Shut down your computer 
• Connect switch box as per instructions 
• Plug in switch(es) to switch box 
• Start Computer (even if you are using a USB switch box, it is wise to shut down for 

connection and restart) 
• Open Clicker  
• Log on in switch user 
• Go to Options Menu – User Access – Switch connection and select the one 

connected. 
 

Test out the switches and be clear what is happening yourself,  
before bringing the user in to use it! 

 
Mouse Dwell Setting 
There is one other special access setting option that can be useful for a user who just 
about manages to move the cursor using a mouse or joystick, trackball or – especially – 
another kind of mouse alternative (such as a head mounted optical pointer), but who might 
have difficulty also clicking. 
 
Options Menu – User Access – Access Method – Mouse Dwell – Timings – Scan or 
Dwell Delay – try about 15 to start with (experiment – too short a dwell delay is 
frustrating as all sorts of mis-selections are made and have to be deleted, but too long a 
dwell time is too hard to manage and may be physically too demanding or tiring).    OK 
Try it. Just point the mouse at the cell you want, and wait.  
 
Switch and Scan 
Scan Order 
The user needs to be able to scan through the cells on a grid in a sensible order, from left 
to right / top to bottom order (not jumping around all over the screen).  
 
This is quite straightforward if you make a regular grid-shaped grid (e.g. using one of the 
‘picture grid’ or ‘word grid’ templates) – it will automatically assign a regular scan order to 
the cells. But you may have problems if  

a) you create an irregular grid (Clicker will not know in what order to assign the scan); 
b) you adapt a grid and delete, insert or move cells around (they take their scan order 

with them, so will get out of sequence);  
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c) you use a pre-made Clicker Grid downloaded from the internet 
(www.learninggrids.com) which probably wasn’t set up with scan and switch users in 
mind and may either scan erratically all over the place when you change to switch 
access, or which may be set up in scan groups (see below) that you want to alter / 
simplify.  

 
To check out the order of the scan, do File - New Grid. Select the default word grid 
that comes up. Then go to Grid – Show Scan Order. The grid will now appear with little 
red boxes in the top left hand corner of each cell with numbers in them. The grid now 
looks like this. 
The first number in 
the red box is the 
Group (these are all 0 
on this simple regular 
grid) and the second 
number is the order in 
which the cells will 
scan.  
  
 
Scan groups 
With a competent switch user, if you want to scan more complex grids (especially for 
writing sentences, for example some of the ‘sentence building’ templates within Clicker, or 
some ready-made grids from the internet), you may need to adjust the scan order.  
 
First check the existing scan order.  
The grid below is one of the ‘sentence building’ templates in Clicker. The grid was not 
created for switch use, so the scan order will need to be checked and possibly altered.   
 
When you look closely at the scan order it is just a straight run through Group 0 and then 
Order 0 to 11.  

 
But in order to work on a particular type of sentence structure exercise ‘Subject EAT 
Object BUT NOT Object’ (or whatever), the user may need to scan through the grid in 
separate sections or groups, and then through the cells numbered within each group.  
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For example, choose which animal first (Group 0, 0-3), then add the verb EAT (Group 1), 
then select an appropriate food (Group 2, 0-3), then BUT NOT (Group 3), then a relevant 
other object (Group 4, 0-3). 
 
To make such changes, go to Grid and the Show Scan Order. You will then see the red 
boxes in the corners. 
 
To make the changes to the scan order you need to change each cell individually. Firstly 
move the mouse over the cell and Shift + Right Click (PC) or Command + Click (Mac)  
 
The Cell Properties window comes up. 
 
Within Cell Properties, click on the Switch Access tab at the top.  
 
You then get a chance to change the 
Group and / or the Order. 
 
(Here you can also change other 
settings for the scan style including 
the colour and width if you wish)  
 
 
 
 
 
 
 
TIP / Short Cut: 
To change a whole group of cells at once, you can select the cells you want, using CTRL + 
left click or (Mac) CTRL + Command click.   
 
Then Grid – Cell Properties, then change the Group number for all the cells at once.  
 
Then click to tick the ‘Automatically Create Scan Order’  box.  
 

Page 45 



If it still isn’t quite right, you will need to go in and change each cell individually. 
 
 
 
 
 
 
 
 
 
 
 
 
 
You will find all this needs a little thought about the language and the order that is needed 
to construct the sentence or story, and about how a switch user needs to access it.  
Unfortunately, most switch users need carefully designed, simpler grids  - it is often not 
as easy as just taking a pre-made grid and ‘translating it into an appropriate scan order …… 
 
Phantom Row / Cell 
Many switch users find it particularly difficult to select accurately the first cell of the 
scan (or of a row/ column scan, or within a group scan) as they have to hit the switch once 
to set the scan going then immediately again to select the row or group, then again to 
select the first cell within it.   
 
One way round this is to create a sort of ‘phantom’ row that gets scanned (to take the 
pressure off and give the switch-user time to get organised) but doesn’t have any items in 
it.   
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Clicker Explorer  
 
Clicker Explorer can also be scanned, giving the skilled switch user independent and fast 
access to both grids and Clicker Writer documents. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To make Clicker Explorer scan:  
 
1. Make sure you are in Clicker Explorer 
and then go to Options and then User 
Access  
 
2. The User Access will open up. Now 
click on the Scan Type tab and click on 
Scan Clicker Explorer.  
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Clicker 4, Wordbar and ClozePro Grids 
Downloading onto your PC                              

Quick Guide 
 
Created: 12/04 
Updated 03/05 

 

LearningGrids.com (www.learninggrids.com) 
 
LearningGrids.com is a huge and continuously growing bank of ready-to-use resources and is a free service is 
for teachers and other users of Clicker 4, Wordbar and ClozePro. The site has a collection of high quality 
resources, many with graphics that are ready to use, but can also be easily modified.  
 
When you go to the web site you will be asked if you want to go to the UK or the US site. Click on UK site 
which will take you to the Welcome to LearningGrids.com screen shown below. 
 

 
 
Browse through the resources before 
downloading them for use in the classroom. To 
download the free resources you need to log in 
with your user name and password. If you (or your 
school) do not already have a user name and 
password, it is a very straightforward procedure 
to get registered. 
 
 
 
 
 
 

 
Near the top of the screen you will see the link to FREE registration.  
 
 
 
 
 
 
 
 
 

CALL Centre 
University of Edinburgh, Paterson’s Land, 
Holyrood Road, Edinburgh, EH8 8AQ 
Tel: 0131 651 6236 
http://www.callcentrescotland.org.uk Copyright © CALL Centre 2003 
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You are asked for your name, organisation and email 
address but this information is used only for identification 
and is never passed on. You will have to choose a username 
and a password. You have to choose a unique username and, 
if the name you choose has been used by someone else, 
then you will be asked to choose a different user name. You 
can also tick a box if you want to receive copies of the 
email Learning Grids newsletter.  
 
When you have completed the form click on the Register 
button. 
If you have chosen a unique user name you will see 
Registration Completed window. A copy of your user name 
and password will be sent to your email address.  
 

 
 
 
 
 
 
 
 
Click on the Continue … link which takes you back to the Welcome to LearningGrids.com screen. This time 
click on Login 

 
 
 
 
 
 
 
 
 
Type in your user name and password and then 
click on the Log in button. 
 
 
 
You are now ready to select and download resources. The grids have been organised into categories which 
you will see in a  list on the left of the screen, starting with Access and Communication. Click on the category 
required e.g. Literacy which links to the sub category groups eg Rhymes. 
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The information on the page tells you how many and what type the grids are. There may be grids of just one 
type or there may be a mix of any of the three programs i.e. Clicker4, ClozePro and WordBar. Please make 
sure that you download the correct type of grid.  
E.g. in the sub-category Rhymes 
there is a ClozePro Grid and some 
Clicker4 grids.  
Click on the Grid you want to get 
some more information and the 
download icon. 
 
E.g. Winter Rhymes 
 
 
 
 
 
 
 
 To download to 

a Windows PC 
Click on the 
Windows icon. 

 
 
 

 
 
A box appears - select 'Save this program to disk' and 
choose where you want to save the file – it is recommended 
that you save the file onto your desktop or a floppy disk or 
other removeable media e.g. pen drive. 
 
 
 
 
 

 

 
 
When the the .exe file has downloaded, double-click on its’ icon to install  
the grid.  
 
 

 
 
 
 
 
The CGfL installation window opens.  
 
Follow the instructions on the screen. 
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During installation, you can choose the folder or 'category' where you want it installed - the default 
directory and folder is usually the best option but if you want to change it, click ‘Browse’ when the installer 
asks for a ‘Destination Directory’ and choose a folder.  
 
 
 
The ‘Please Read’ screen tells you exactly how to 
get to the grid that has just been installed – for 
the Rhymes grid downloaded in this example, it is in 
the CGfL folder, in the Themes folder, in the 
Seasons folder, in a folder called Winter Rhymes.  
 
 
 
 
 
 
 
When you have installed the resource, you can delete the .exe file you downloaded to your computer or, if 
you have it on a floppy disk or pendrive you can install it on other computers. The downloaded grid(s) are in 
the Clicker Grids for Learning (CGfL) folder. 
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Clicker 4  
Shortcuts  (Mac)                                 

Quick Guide
 
Updated 03/05 
 SO 

 

To edit text in a cell: 
Edit cell text Shift click 
Move to next cell Tab 
To finish editing text Return 
 
Working with cells: 
Select a single cell Control-click 
Deselect a cell Control-click on selected cell 
Select all cells Grid menu > Select All Cells  
De select all cells Click on Grid (not on a cell) 
Select multiple cells Control, command click on cells 
Delete a cell Select cell and Grid menu > Delete > Cell 
To get a cell to speak Ctrl-click 
 
Shortcuts to menus:  
Pop up cell properties menu Command (Apple)-Click on cell 
 
Moving and resizing cells: 
Move a cell Alt (option) drag  
Resize a cell Alt (option) drag - any corner of the cell 
  
Graphic boxes: 
Editing Shift-click on graphic box 
Moving Alt (option) - drag 
Resizing Alt (option) - drag any corner 
 
Text boxes: 
Editing Shift-click on text box 
Moving Shift-click, option-drag 
Resizing Shift-click, option-drag any corner 
 

To turn the keyboard shortcuts off 
Check Disable easy editing on the Other tab of the User Preferences dialog box. 

CALL Centre 
University of Edinburgh, Paterson’s Land, 
Holyrood Road, Edinburgh, EH8 8AQ 
Tel: 0131 651 6236 
http://www.callcentrescotland.org.uk Copyright © CALL Centre 2005 
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Clicker 4  
Shortcuts (PC) 

Quick Guide
 
Updated 03/05 
 SO 

 
Left and right click refer to mouse buttons  

To edit text in a cell 
Enter or change text Shift left click 
Move to next cell Tab 
To finish editing text Return 
 
Working with cells 
Select a single cell Right click 
Select another cell Ctrl left click 
Select multiple cells Ctrl drag left or Shift drag left 
Select all cells Grid menu > Select All Cells  
De-select all cells Click on Grid (not on a cell) 
Delete a cell Select cell and Grid menu > Delete > Cell 
To get a cell to speak Right click 
 
Shortcuts to menus 
Cell properties Shift right click while pointing at cell 
Grid properties Shift right click while pointing at background 
 
Moving and resizing cells 
Move cell Alt drag left 
Resize cell Alt drag left while pointing at bottom right corner of cell  
Graphic boxes 
Editing Shift-click on graphic box 
Moving Alt–click and drag 
Resizing Alt–click  drag any corner 
 
Text boxes 
Editing Shift-click on text box 
Moving Alt-click and drag 
Resizing Alt-click and drag any corner 
 
To untrap mouse Shift right click on a cell 
 

To turn the keyboard shortcuts off 
Check Disable easy editing on the Other tab of the User Preferences box. 

CALL Centre 
University of Edinburgh, Paterson’s Land, 
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